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Vorbemerkungen
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Vorbemerkungen

• Die vorliegende Dokumentation gilt dem Erstanwender der OrCAD Capture Software. Sie soll weder 

als Trainingshandbuch noch als komplette Bedienungsanleitung verstanden werden. 

• Aufgrund der Kompaktheit dieser Dokumentation kann nicht auf alle vorhandenen Befehle und deren 

Feinheiten eingegangen werden. Hierzu sei auf die umfangreiche Dokumentation innerhalb der 

Installation verwiesen, die sowohl als HTML wie auch als PDF Dokumentation vorliegt.

• Anhand eines einfachen Schaltplans werden die wichtigsten Schritte innerhalb des Designablaufs 

dargestellt, die es dem Erstanwender dieses Systems erlauben, mit einem Minimalaufwand an 

Einarbeitungszeit die ersten eigenen Aufgaben zu bewältigen.

• Nach einigen Vorabinformationen zur Software beginnt die Anleitung mit der Schaltungsvorlage 

auf Seite 7. 

• Sämtliche Befehle und Funktionen, die in dieser Anleitung verwendet werden, sind mit der Trial-

Version verwendbar.
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OrCAD PCB Design Flow

• Wie in der Grafik zu erkennen ist, setzt sich der OrCAD PCB Designer Flow im Wesentlichen aus 

zwei Teilen zusammen.

− Dies sind das Stromlaufplanpaket Capture und das Layout Programm OrCAD PCB Editor.

• Beide Programmpakete werden natürlich durch weitere Subprogramme ergänzt, die im jeweiligen 

Verbund ein optimales Werkzeug darstellen, das es dem Anwender ermöglicht, sämtliche Aufgaben 

mit maximaler Effizienz zu erledigen.
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Capture Design Flow

Die Grafik zeigt den typischen Ablauf bei der Erstellung eines Stromlaufplans für den anschließenden 

Layout Entwurf. Die Punkte 1 bis 10 stellen die einzelnen Arbeitsschritte im Designablauf dar, auf die im 

Folgenden näher eingegangen werden soll. Der Hauptarbeit beginnt mit der Projekterstellung und endet 

mit dem Generieren eines Layouts. 
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Schaltungsvorlage

Die Schaltung, die in diesem Schnellstart umgesetzt werden soll, ist hier dargestellt:
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Schaltungsvorlage – Liste der Bauteile

Die Schaltung, die in diesem Schnellstart umgesetzt wird, beinhaltet die folgenden Bauteile:

REFERENCE VALUE PART_NUMBER PCB Footprint

C1 220u FC-CAP-0057 capp_taj_e

C2 220u FC-CAP-0057 capp_taj_e

C3 100n FC-CAP-1019 cap_th_s_rm15x17_5x7x13_5

C4 100n FC-CAP-1019 cap_th_s_rm15x17_5x7x13_5

L1 100n FC-IND-0003 ind_0805

R1 1.2k FC-RES-0356 res_th_a_rm10_16x2_54

R2 22k FC-RES-0001 res_3269w

T1 EI30 FC-TF-0001 ei30_1579

U1 B40C800 FC-REC-0001 rec_b40_tht

U2 LM317 FC-IC-0001 sot223
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Start von Capture

Nach dem Start von Capture 

öffnet sich das Capture 

Session Frame Fenster. 

Start über:

Start > 

Cadence PCB 17.4 2019 > 

Capture CIS 17.4



10FlowCAD Confidential  │

Start Page

Beim Start wird die interaktive Startseite geladen, mit der Sie vorhandene Projekte öffnen bzw. neue 

erstellen können. Des Weiteren erhalten Sie zusätzliche Information wie Application Notes, 

Trainingsdaten, usw.
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Neues Projekt aufsetzen
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Übung: Neues Projekt erstellen

File > New > Project… erstellt ein neues Projekt, 

in dem das Design gespeichert wird.

Da wir keine Simulation durchführen wollen, bleibt 

Enable project simulation deaktiviert.

Im oberen Feld unter Name tragen Sie den 

Namen Ihres Projekts ein, z. B. Power_Supply.

Als Projekt_Typ wählen Sie PC Board Wizard, da 

wir mit diesem Projekt später auch ein Layout 

erstellen wollen.

Im unteren Feld unter Location wählen Sie den 

Ordner, in dem das neue Projekt gespeichert 

werden soll. 

Empfehlenswert ist es für jedes Projekt einen 

eigenen Ordner anzulegen.
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Projekt Power_supply

Ein neues Projekt namens 

Power_supply mit einem Design 

gleichen Namens power_supply.dsn

ist angelegt.

Gleichzeitig wurde die erste Seite 

Ihres Designs mit dem Namen 

PAGE1 geöffnet. 

Bitte beachten Sie die Ordnerstruktur 

im Projektmanager auf der linken 

Seite des Bildes.

Die Ordnerstruktur ist virtuell, d. h. sie 

existiert nur innerhalb des 

Projektmanagers. Die unter 

Schematic befindliche PAGE1 ist nur 

innerhalb des power_supply.dsn

Files zu finden. 

Im Unterschied dazu sind die unten 

eingetragenen Libraries als 

physikalische Files unter den 

ebenfalls dargestellten Pfaden 

vorhanden.
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Setup – Grid Display

Unter Options > Preferences sollte im Grid 

Display das Grid Spacing auf 1/1 stehen. 

Dies stellt sicher, dass die Kontaktpunkte der 

Bauteile auf dem Grid liegen und problemlos 

angeschlossen werden können.

Snap to Grid sollte beim normalen Arbeiten mit 

Capture aktiviert sein, um zu vermeiden, dass 

Bauteile außerhalb des Grids platziert werden:
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Setup – Rahmen

Das Erscheinungsbild des Rahmens lässt sich unter Options > Schematic Page Properties einstellen. 

In den Grid References können Sie die Unterteilung des Rahmens und dessen Breite festlegen (Capture 

passt die Rahmenbreite an die Grid Einstellungen an).

Tipp

Die Einstellungen lassen sich auch in ein 

Template speichern, das sich auf alle neuen 

Pages und Projekte auswirkt. 

Hierzu können die Einstellungen unter Options > 

Design Template gemacht werden. 

Näheres hierzu ist im Kapitel Einstellungen und 

Vorlagen ab Seite 82 zu finden.
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Bauteilplatzierung
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Bauteilsuche über Datenbank (I)

• Der CIS Explorer lässt sich über das Pull-down-Menü mit Place > Database Part starten oder über 

das Tastaturkürzel Z.

• In der oberen linken Ecke finden Sie die verschiedenen Datenbank-Tabellen.
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Bauteilsuche über Datenbank (II)

• Öffnen Sie die Kategorie misc_view und selektieren den Ordner Crystal. Im unteren Fenster 

erscheint ein Tabelleneintrag. Wenn dieser selektiert wird, öffnet sich die komplette Vorschau des 

Bauteils (die Anordnung der Fenster kann individuell gestaltet werden).

Der Eintrag unter Datasheet ist ein Link zum Datenblatt des Herstellers. Durch einen Doppelklick auf 

den grün hinterlegten Eintrag hängt das Bauteil an der Maus und kann auf der Schaltplanseite 

platziert werden. 

• Mit dem Tastaturkürzel Z tritt der CIS Explorer wieder in den Vordergrund.
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Bauteilsuche über Datenbank (III)

• Öffnen Sie die Kategorie cap_view und selektieren X7R. Im unteren Fenster erscheinen mehrere 

Einträge. 

• Durch Doppelklick auf eine Spaltenüberschrift wird die Liste nach diesem Wert sortiert. 

• Wenn der Kondensator mit 4.7pF im 0603-Gehäuse gewählt wird, erscheinen in der Herstellertabelle 

zwei mit dem Bauteil verknüpfte Datensätze mit Herstellerinformationen. 

• In der Spalte Schematic Part kann die grafische Darstellung im Schematic ausgewählt werden.
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Bauteilsuche über Datenbank (IV)

• Das linke obere Fenster hat zwei Tabs. Mit Query besteht die Möglichkeit, Bauteile über deren Werte 

zu suchen. Der 4.7pF Kondensator lässt sich z. B. auch mit Eingabe der unten gezeigten Werte 

finden. Die Felder Property und Compare sind mit Dropdown-Menüs ausgestattet, die eine einfache 

Auswahl der Suchoptionen ermöglicht.
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Bauteilstatus

• Wenn Sie im CIS Explorer auf die Kategorie cap_view gehen, sehen Sie, dass die aufgeführten 

Bauteile unterschiedlich eingefärbt sind:

− Standard Bauteile sind grün

− Gesperrte Bauteile rot

− Spezielle Bauteile schwarz
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Bauteilplatzierung ohne Datenbank
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Bauteilplatzierung aus Library

Neben der Möglichkeit Bauteile aus einer Datenbank auszuwählen, die die Metadaten liefert, bietet 

OrCAD Capture auch die Möglichkeit Bauteile direkt aus einer Library (.olb) auszuwählen und zu 

platzieren.

• Vorteil

− Es wird keine Bauteildatenbank benötigt.

• Nachteil

− Alle Bauteilinformationen müssen manuell als Properties definiert werden (Aufwand, fehlerträchtig).

− Ein Varianten Management ist nicht möglich.
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Bauteilplatzierung aus Library

Um neue Bauteile zu platzieren, 

können Sie eine der drei 

Möglichkeiten nutzen:

• Place > Part... über 

das Pull-down-Menü

• P (Tastatur)

• Place Icon

am rechten Rand

Tipp

Damit die Schematic Icon-

Leiste sichtbar ist (rechter 

Rand), muss eine der in 

der Schematic vorhandenen 

Seiten aktiviert sein.
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Bauteilplatzierung aus Library

• Nach dem Platzierungskommando erhalten Sie das 

abgebildete Menü.

• Unter Libraries können Sie eine oder auch mehrere 

Libraries anwählen, in welchen nach Ihrem Bauteil 

(Part) gesucht werden soll.

• Unter Part wird die Bauteilbezeichnung eingegeben. 

Diese fungiert bereits als Filter, allerdings ohne 

Wildcards „*“.

• In der Part List wird das Suchergebnis und die 

zugehörige Library ausgegeben.

• Search for Part erlaubt ein Suchen auch mit 

Wildcards.

• Add Library erlaubt das Hinzufügen von 

Libraries in den Suchpfad.

• Unter Packaging wird angezeigt, ob ein Baustein 

aus mehreren Gattern bzw. Sektionen besteht 

(z. B. Widerstandsnetzwerk).

• Mit einem Doppelklick in der Part List gelangen Sie 

zurück in das Schematic und können das Bauteil mit 

der LMB (Left Mouse Button) platzieren.
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Library Zuweisungen

• Hier werden die in dem Projekt benötigten 

Libraries zugewiesen.

• Im linken Fenster befinden sich alle Libraries, 

die bei der Installation der Software installiert 

wurden. Es können jederzeit Libraries 

nachgetragen werden. Im rechten Fenster sind 

die dem Projekt zugeordneten Libraries 

gelistet.

• Die Zuweisung erfolgt durch Selektion der 

gewünschten Library und Add.

• Wie Sie neue Bauteile, die in keiner 

vorhandenen Bibliotheken zu finden sind, 

definieren können, ist im Kapitel Bibliotheken

ab Seite 62 beschrieben.
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Hinzufügen von Texten
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Text – Hinzufügen und Bearbeiten

Reine Text Notes können mit 

• Place > Text

• T (Tastatur)

oder dem

• Place Text Icon 

dem Schematic hinzugefügt werden.

Schriftart und Größe lässt sich beim Platzieren 

des Textes mit Change anpassen.
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Verbindungen
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Verbindungen (I) – Auto Wire

Two Points 

− Zwei selektierte Pins werden automatisch 

miteinander verbunden.

Multiple Points

− Mehrere selektierte Pins werden automatisch 

miteinander verbunden.

Connect to Bus

− Mehrere selektierte Leitungen werden mit 

einem Bus verbunden. 
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Verbindungen (II) – Auto Wire

Wenn Sie beispielsweise Auto Connect Two Points aktivieren, müssen Sie im Schaltplan nur zwei Pins 

oder Leiterbahnen selektieren und die Leitung wird automatisch gezeichnet.
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Verbindungen (III) – Manuell

Das Verbinden kann auch manuell 

erfolgen:

• Place > Wire

• W (Tastatur)

oder dem 

• Place Wire Icon  

Beim manuellen Platzieren muss 

die Leitung bei jedem 

Richtungswechsel durch links 

Klicken abgesetzt werden.

Ansonsten ist die Vorgehensweise 

identisch zum Auto Wire-Befehl.
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Verbindungen (IV) – Arbeitsweise

Das Verdrahten erfolgt durch einen Klick

auf ein offenes Ende, gekennzeichnet durch 

ein Quadrat am Pin. Dieser Marker erlischt 

nach dem Anschluss einer Verbindung.

Der rote Punkt kennzeichnet ein Pin, 

welcher nun zum Anschließen zur Verfügung 

steht. Ein weiterer Klick auf diesen Punkt 

vervollständigt die Verbindung, und der rote 

Punkt wie auch das Quadrat verschwinden. 

Ein Doppelklick beendet die aktuelle 

Verbindung.

Kreuzungen stellen nur dann eine 

Verbindung dar, wenn manuell ein Dot bzw. 

Junction gesetzt wird oder eine T-

Verbindung als Zwischenschritt genutzt wird.

Durch einfaches Selektieren einer 

Verbindung und Drücken der Entf-Taste

kann eine bestehende Verbindung wieder 

gelöscht werden. 
Tipp

Die Ctrl-Taste erlaubt die gleichzeitige Selektierung 

mehrerer Elemente.
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Verbindungen (V) – Netznamen

Netznamen vergeben

Sollen auf einer Seite Bauteile miteinander verbunden werden, so 

erfolgt dies mittels des Place > Wire Kommandos durch das 

Ziehen von Drahtverbindungen.

Eine weitere Möglichkeit besteht in der Verwendung 

von Net Aliases.

Place > Net Alias...

Place Net Alias Icon

Hierbei wird den Netzen ein Netzname zugewiesen und darüber 

die Verbindung zweier Bauteile realisiert. 

Als Beispiel dient hier das Netz mit dem Namen plus.

Tipp

Sollen Netze mittels Netznamen über mehrere Seiten oder auch über das Design hinweg verbunden 

werden, so sind Offpage Connectoren bzw. Port Connectoren zu verwenden. 

Näheres hierzu ist in der Dokumentation ersichtlich.
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Properties editieren
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Properties editieren (I)

Etwa so dürfte der fertige Stromlaufplan nach Platzierung und Verdrahtung aussehen:

Unter Umständen 

stimmt die Beschriftung 

der Bauteile (RefDes, 

Value) nicht mit der 

Schaltungsvorlage auf 

Seite 7 überein.

Um dies zu korrigieren, 

können die Values

und REFDES der 

Bauteile editiert 

werden, was auch im 

Sinne einer späteren

Stückliste ist.  

RefDes

Value
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Properties editieren (II)

REFDES und Value editieren

Das Property Fenster kann durch 

Selektieren (LMB) und RMB > Edit Properties …

oder durch einen

Doppelklick

der gewünschten Property geöffnet werden.

Über Display Format sind verschiedene Einstellungen 

bezüglich der Sichtbarkeit im Stromlaufplan möglich.

Tipp

Es können gleichzeitig mehrere oder alle Symbole einer 

Seite oder gar des gesamten Designs im Property Editor 

aufgerufen werden.

• Ctrl + LMB-Klick oder Ctrl + A und anschließend 

RMB > Properties...

• Im Project Manager, Page oder Design (.dsn) selektieren, 

Edit Object Properties aus dem Pull-down-Menü.
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Packagen – Annotation

Packagen und Annotierung von Bauteilen

Auf der vorherigen Seite haben Sie die Referenzen der 

Bauteile manuell vergeben. Während des Editierens 

kontrolliert Capture nicht, ob Sie doppelte Bezeichner 

(2 x U1, oder 3 x R5) vergeben haben. Die Kontrolle 

erfolgt erst beim Generieren der Netzlisten.

Über Tools > Annotate… haben Sie aber die 

Möglichkeit, diese Arbeit automatisch zu erledigen, und 

das ohne doppelte Bezeichner. Hierbei sind vielfache 

Optionen wählbar (selektieren Sie im 

Projektverzeichnis zuerst die .DSN Datei, sonst ist der 

Befehl Annotate nicht verfügbar).
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Fertiger Stromlaufplan

Nachdem die Schaltung angepasst und evtl. Elemente und Beschriftung ausgerichtet wurden, sollte der 

fertige Stromlaufplan in etwa das hier gezeigte Aussehen haben.

Anmerkung

An dieser Stelle sei angemerkt, dass in 

Abhängigkeit der verwendeten Libraries 

die Zuweisung der Footprints (DIP14, 

SO14, SMD1206 usw.) unter 

Umständen in dieser Schaltung noch 

nicht erfolgt ist.

Mit diesem Thema werden wir uns zu 

einem späteren Zeitpunkt (beim 

Importieren der Netzliste in das 

Layoutprogramm) befassen.

Hier nur soviel:

Die Footprint Zuweisung muss bereits 

im Schaltplan erfolgen. Ein fehlender 

Footprint Eintrag führt zu einer 

Fehlermeldung bei der Netzlisten-

Generierung.

Ist der Name noch nicht klar, kann 

irgend ein Text eingegeben werden. 

Footprints können in der Library 

vorgegeben sein oder über den Property 

Editor nachgepflegt werden.
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Design Rule Check

Mit dem DRC lassen sich z. B. 1-pinnige 

Netze und Netze ohne Input oder Output 

erfassen, sofern die Libraries richtig 

definiert wurden.

Selektieren Sie im Projektverzeichnis 

zuerst die .dsn-Datei, sonst ist der Befehl 

Design Rule Check nicht verfügbar.



41FlowCAD Confidential  │

Materialliste (BOM)
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Design Varianten
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Varianten – Übersicht

• Zum Erzeugen von Design Varianten sind diese Schritte notwendig:

− Aufteilen des Designs in sinnvolle Gruppen, z. B. nach Funktionsblöcken

− Erzeugen von Subgroups, die die Bestückungsvarianten der Blöcke wiederspiegeln

− Erzeugen der BOM Varianten des gesamten Projekts (dies sind die eigentlichen Varianten, 

die der Bestücker verwendet)

− Hinzufügen der Subgroups zu den BOM Varianten, so dass die gewünschte Bestückung entsteht

• Diese Schritte werden im Detail auf den nächsten Seiten erklärt. 
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Varianten – Beispieldesign

• Der Capture Schnellstart Datensatz enthält ein Varianten-Beispieldesign:

− ~\Capture_CIS_Schnellstart_17_4\Solutions\VARIANT_DESIGN.DSN

− In dem Übungsbeispiel sind bereits Groups, Sub-Groups und Varianten vorkonfiguriert.

− Die Variantenerstellung wird in diesem Kapitel beschrieben.
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Varianten – Groups

• Mit dem Part Manager verwalten Sie die Bauteile im Design, führen Datenbank-Updates durch oder 

generieren Varianten.

• Zum Starten, selektieren Sie das DSN File und klicken RMB > Part Manager oder nutzen im Menü 

Tools > Part Manager > Open.

• Um Varianten zu beschreiben, müssen Sie das Design in Gruppen aufteilen. 

• Es ist sinnvoll, alle Bauteile einer Funktionsgruppe in jeweils eine Gruppe der Variantenbeschreibung 

abzulegen. Funktionsgruppen, die keine Bestückungsvarianten haben, verbleiben in der Common 

Group.

• Selektieren Sie Groups > RMB > New Group. Erstellen Sie eine Gruppe Clock. Wiederholen Sie 

diesen Vorgang und generieren die Gruppe PCIE.
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Varianten – Subgroups

• Als nächstes werden die Subgroups definiert, die die unterschiedlichen Bestückungsvarianten der 

Gruppen enthalten. 

• Selektieren Sie hierzu die Gruppe Clock > RMB > New Subgroup. 

• Geben Sie Alternate ein. 

• Wiederholen Sie diesen Vorgang, und geben HalfMounted und dann FullMounted ein.
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Varianten – Bauteile Gruppen zuweisen

• Öffnen Sie die Seite Clock und selektieren Sie alle Bauteile.

• RMB > Add Part to Group, wählen Sie die Gruppe Clock > Add. 

• Wiederholen sie diese Aktion mit der zweiten Seite und schieben alle Kondensatoren, nicht den 

Stecker, in die Gruppe PCIE.
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Varianten – Nicht bestückte Bauteile

• Gehen Sie in den Part Manager und selektieren eine Subgroups HalfMounted. 

• Selektieren Sie einige Bauteile und setzen diese mit RMB > Set Part as not present. 

• Alle nicht bestückten Bauteile sind mit einem roten Kreuz markiert.

• Wiederholen sie diese Aktion in einer anderen Subgroup.
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Varianten – Alternative Bestückung

• Gehen Sie in die Subgroup Alternate und selektieren ein Bauteil, vorzugsweise einen Widerstand 

oder Kondensator RMB > Link Database Part. 

• Der CIS Explorer öffnet sich, und es kann ein alternatives Bauteil ausgewählt werden. Achten Sie 

darauf, dass die Bauteile identische Symbole und Footprints haben. Dies kann 

z. B. durch eine Query-Suche sichergestellt werden, bei der der Footprint vorgegeben wird.

• Der CIS Explorer unterstützt Sie bei Ihrer Suche. Properties mit unterschiedlichem Inhalt sind rot 

markiert.

• Link Database Part funktioniert auch, wenn Sie mehrere gleiche Bauteile im Part Manager 

selektieren. Alle Bauteile mit alternativer Bestückung sind mit einem grünen Haken markiert.
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Varianten – Stückliste definieren

• Selektieren Sie BOM Variants > RMB > New 

BOM Variants und geben Sie den Namen 

BOM1 ein. Wiederholen Sie diesen Vorgang 

mit für BOM2 und BOM3.

• Ziehen Sie jeweils eine Subgroup pro Gruppe 

in die BOM. Abschließend muss die Common 

Group noch in die BOM übernommen werden, 

da sie den PCIE-Stecker enthält, der keiner 

Gruppe zugewiesen wurde.

• Die Variant BOM ist rechts unten abgebildet.
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Varianten – Schaltplan

• Schließen Sie den Part Manager, gehen auf 

eine Schaltplan-Seite mit 

Variantenbeschreibung und selektieren 

View > Variant View Mode. 

Selektieren Sie eine der Varianten. Nicht 

bestückte Bauteile werden grau mit dem 

Schriftzug DNI, Bauteile mit einer 

alternativen Bestückung werden grün 

dargestellt. 

• Die Farben können Sie über Options > 

Preferences einstellen.
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Varianten – Report

• Mit dem Variant Report können Sie Varianten 

Definitionen überprüfen bzw. mit den Core-

Design vergleichen. 

Öffnen Sie den Part Manager und selektieren 

Report > Variant Report. Setzen Sie die 

Einstellungen wie im Bild gezeigt. Selektieren 

Sie eine der Varianten > OK. 

• Der Report wird erzeugt und dargestellt. Sie 

bekommen eine direkte Gegenüberstellung 

von Core-Design und Variante.
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Varianten – Stückliste erzeugen

• Die Varianten Stücklisten lassen sich wie auf Seite 41 gezeigt über Report > CIS Bill of Material > 

Standard generieren. 

• Nutzen Sie ein existierendes Template und selektieren Sie unten eine der Varianten. 

• Über der Liste mit den Varianten finden Sie Variants Not Stuffed Qty 0 Displayed. 

Mit einem Haken dort werden alle nicht bestückten Bauteile mit der Anzahl 0 in der Stückliste mit 

ausgegeben. 

• Mit OK starten Sie die Stücklisten Ausgabe. Die Varianten BOM wird angezeigt.
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Constraint Manager
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Constraint Manager in Capture

• Diese Kapitel im Capture Schnellstart gibt nur einen kurzen Überblick über den Constraint Manager.

• Ausführlichere Informationen finden Sie im PCB Editor Schnellstart ab Seite 73.
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Constraint Manager in Capture

• Um den Constraint Manager aus Capture zu 

starten, gehen Sie auf PCB > Constraint Manager 

oder nutzen das Icon       .

• Die Abfrage bestätigen Sie mit Migrate constraints 

from schematic design.
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Spannungen den Power Netzen zuweisen

• Im nächsten Fenster lassen sich beim ersten 

Start des Constraint Managers den 

Powernetzen Spannung zuordnen.
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Constraint Manager in Capture

• Aus dem Schematic macht vor allem die Definition der elektrischen Constraints Sinn.

• Viele Constraints benötigen Informationen aus dem Layout, die erst nach einem Backannotate

verfügbar sind.
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Design Sync
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Layout generieren (I)

Über PCB > New Layout lässt sich die 

Logikinformation in ein neues PCB übertragen.

• PCB Layout Folder: Verzeichnis, in das die 

Design Sync Information geschrieben wird

• Input Board File: Ein Basis oder Board 

Template

• Board: Neu generiertes Board File
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Layout generieren (II)

• Über PCB > Design Sync lässt sich ein vorhandenes PCB aktualisieren.

• Änderungen werden in Form eine ECO List angezeigt.
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Bibliotheken
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Fehlende Bauteile

In diesem Kapitel wird beschrieben, wie Bauteile in Web Portalen über die Funktion Search Providers

gesucht werden können, bzw. neue Bauteile erzeugt werden, die nicht in den von OrCAD bereitgestellten 

Bibliotheken vorhanden sind.
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Bauteilsuche (I)

• Sollten benötigte Bauteile nicht in den 

vorhandenen Bibliotheken verfügbar sein, 

haben Sie die Möglichkeit über die Webportale 

Ultra Librarian und SamacSys Bauteile 

kostenlos herunterzuladen.

• Die Webportale bieten Datasheet, Schematic 

Symbol, Footprint und Step Modelle.

• Zum Starten der Websuche gehen Sie auf 

Place > Search Providers.

• Zur Suche über die Webportale benötigen Sie 

einen Cadence und Ultra Librarian Account.

• Wenn Sie keinen Account haben, nutzen Sie 

die Registration links unter Click here um sich 

kostenfrei zu registrieren.
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Bauteilsuche (II)

• Die Search Providers Oberfläche bietet eine Google-artige Suche 
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Bauteilsuche (III)

Sollten benötigte Bauteile nicht in den vorhandenen Bibliotheken verfügbar sein, können diese von den 

Webportalen heruntergeladen werden.

Datasheet     Schematic Symbol     Footprint     Step Model verfügbar

Die Bauteile werden beim Platzieren über 

rechte Maustaste > Place Part

automatisch heruntergeladen und in der Site 

Umgebung gespeichert unter:

~/Site/Library/downloaded_parts
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Bauteil Erstellung

Neue Bauteile können auch mit den in Capture vorhandenen Mitteln erstellt werden.

Die Vorgehensweise wird am Beispiel des LM317 dargestellt, der nicht in den ursprünglich 

angebundenen Libraries

• Counter.olb

• Discrete.olb

• OPAMP.olb

aufzufinden war.

Das fertige Bauteil ist in der 

• Quickstart.olb

vorhanden.
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Neue Bibliothek (I)

Sie können neue Elemente in einer neuen Library 

anlegen 

oder 

eine bestehende Library öffnen, und hier neue 

Bauteile hinzufügen.

Beide Aktionen erfolgen über

• File > New > Library

oder

• File > Open > Library
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Neue Bibliothek (II)

In Capture kann über RMB > Save As... die neue 

Library im gewünschten Pfad abgespeichert 

werden.

Diese Library kann anschließend in Ihr 

bestehendes Projekt eingebunden werden. 
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Bauteil anlegen (I)

Mit Design > New Part...

oder

RMB > New Part

starten Sie die Erstellung eines neuen Bauteils in 

der aktuellen Library.
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Bauteile anlegen (II)

Tragen Sie die dargestellten Werte in das Menü ein.

Neuer Bauteilname:

Part Reference Prefix:

PCB Footprint:

Part Aliases:

Gleiches Symbol, gleiche Funktion, aber 

verschiedene Gehäuse

Parts per package:

z. B. 4 Gatter im 74LS00

Homogen:

Mehrere gleiche Schaltungen,

z. B. 74LS00

Heterogen:

z. B. Relais mit Spule und Schalter

Partnummerierung:

U?A, U?B ... oder U?1, U?2 ...

Mit OK bestätigen.



72FlowCAD Confidential  │

Befehle in Capture

In der Capture Oberfläche sind nun die zum Bearbeiten der Bauteils benötigten Befehle verfügbar, 

sowohl als Schaltflächen am rechten Rand, wie auch unter Place. 

Die Funktion der Buttons 

wird durch Mouse Over

Hinweise angezeigt.

Auf den nächsten Seiten 

werden die wichtigsten 

Funktionen kurz erläutert.
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Pins hinzufügen (I)

Platzieren der Pins durch:

• Place > Pin...

oder

• Place Pin Icon
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Pins hinzufügen (II)

Das Place Pin Fenster erscheint, in dem die Pin 

Eigenschaften festgelegt werden.

Wenn OK angeklickt wird, hängt der Pin an der 

Maus und kann platziert werden.

Tipp

Bei Verwendung von Power als Pin Typ kann der 

Pin sichtbar oder unsichtbar geschaltet werden.
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Pins hinzufügen (III)

Die einzelnen Pins werden platziert Weitere Pins können über das 

vorherige Menü oder über 

Copy&Paste (Ctrl C, Ctrl V)

platziert werden.

Die Platzierung der Pins erfolgt 

immer entlang der gestrichelten 

Linie.

Package und Pin Properties 

lassen sich mit dem Property 

Sheet auf der rechten Seite 

anpassen.
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Symbol zeichnen

Fertigstellen des Symbols

Abschließend wird dem Symbol die reguläre Outline zugeordnet.

Dies geschieht durch:

• Place > Rectangle

• Place > Polyline

usw.

Alternativ können die betreffenden Icons auf der rechten Seite des 

Part Editor Fensters verwendet werden.

Tipp

Die gestrichelte Linie ist nur ein Hilfsrahmen, der in dem Schematic nicht 

sichtbar ist. Der Symbolrahmen stellt den realen Platzbedarf der Grafik 

innerhalb des Schematic dar.

Das Rechteck kann selektiert und über die Ecken gedehnt oder 

gestaucht werden. Der gestrichelte Rahmen ist immer mindestens so 

groß wie der reale Symbolkörper, wird aber nur beim Vergrößern

automatisch mitgeführt.
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Fertiges Bauteil

Fertiges Symbol LM317

Speichern nicht vergessen!

Tipp

Weitere Beschriftungen oder 

Symbolik innerhalb des 

Bauteils können über 

Place > Text und Place > 

Line hinzugefügt werden.
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Verwaltung in Bibliotheken

Sie können library1.olb als Power_supply.olb

speichern. In der Power_supply.olb ist jetzt der 

Spannungsregler LM317 gespeichert.

Sollten weitere Elemente benötigt werden, können 

diese ebenfalls innerhalb dieser Library erstellt 

werden.

Die Library kann wie auf Seite 26 beschrieben in 

Design Projekte eingebunden werden.

In der Quickstart.olb sind alle Bauteile vorhanden, 

die in diesem Schnellstart verwendet werden.
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Datenbank bearbeiten
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Datenbank bearbeiten

• Zum Bearbeiten der Datenbankeinträge wird ein SQLite Editor benötigt.

• Dieser kann z.B. hier heruntergeladen werden:

https://sqlitebrowser.org/dl/

https://sqlitebrowser.org/dl/
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Datenbank bearbeiten

• Zur Bearbeitung muss die gewünschte Bauteiltabelle geöffnet werden.

• Dort stehen dann Befehle, wie Copy / Paste und Neue Zeile zur Verfügung.
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Einstellungen und Vorlagen
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Design Template – Title Block

Unter Options > Design Template können 

Voreinstellungen für neue Projekte und neue Seite 

im bestehenden Projekt gemacht werden.

Im Reiter Title Block können das 

Beschriftungsfeld und die darin verwendeten 

Textbausteine gesetzt werden.
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Design Template – Page Size

Unter Page Size wird die Zeichnungsgröße 

festgelegt.

Achtung

Die Einstellung unter Pin-to-Pin Spacing

müssen mit dem in der Library 

verwendeten Pin-to-Pin Spacing

übereinstimmen, um spätere Probleme 

beim Setzen und Verbinden der Bauteile

zu vermeiden.
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Design Template – Grid Reference

Unter Grid Reference wird die 

Breite des Zeichnungsrahmens 

und dessen Unterteilung festgelegt.

Breite

Width

Unterteilungen

Count
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Anhang
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Systemvoraussetzung (Vollversion 17.4)

Betriebssysteme Windows 10 (64-bit) Professional, Windows 2012 Server (All Service Packs); 

Windows Server 2012 R2; Windows 2016 Server

Hardware Intel® Core™ i7 4.30 GHz or AMD Ryzen™ 7 4.30 GHz with at least 4 cores

16 GB RAM

50 GB free disk space (SSD drive is recommended)

1920 x 1200 display resolution with true color (at least 32 bit color)

A dedicated graphics card supporting OpenGL, minimum 2 GB (with additional 

support for DX11 for 3D Canvas)

Dual monitors (for physical design)

Broadband Internet connection for some services



88FlowCAD Confidential  │

Eigenschaften der Vollversion

Allgemein

• Raster in Millimeter und Zoll einstellbar

• Einfaches Erstellen und Bearbeiten von Libraries

• Forward-Backward Annotation

• Cross-Probing zwischen Design Entry (Capture) und Layout (PCB Editor)

Schaltplaneditor Capture

• Zeichenfläche bis 11.430 x 11.430 mm

• Mehrere Designs innerhalb eines Projektes möglich

• Hierarchische Strukturen mit automatischer Synchronisierung

• Automatische Referenzierung der Bauteile

• Electrical Design Rules Check (einstellbar)

• Einstellbarer automatischer Zeichnungsrahmen und Schriftkopf

• Ausgabe verschiedener Netzlistenformate

• TCL Interface
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Bedienkonzept

• OrCAD Capture ist grundsätzlich menügesteuert.

• Die verwendeten Menüs sind kontextsensitiv. Dies bedeutet, dass sich in Abhängigkeit der 

selektierten Elemente, Arbeitsflächen oder Befehle, die resultierenden Pop-up-Fenster bzw. das Pull-

down-Menü verändert.

• Sämtliche Eingaben bzw. Befehle erfolgen über eine der folgenden Möglichkeiten:

• Pull-down-Menüs

• Icons

• Kurztasten

• Pop-up-Fenster

• Es gibt keine klassische Kommandozeile. Allerdings besteht die Möglichkeit, TCL Skripte über das 

Command Fenster auszuführen.
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Dateien in OrCAD (Capture)

Die wichtigsten von OrCAD Capture verwendeten Dateien:

.OPJ Projekt 

.DSN Design

.DBK Backup

.OLB Symbol Library

.UPD Property Update Datei

.DRC Design Rules Check

.BOM Stückliste (Bill of Materials)

.EXP Property Export Datei

.MNL Layout Netzliste

.SWP Layout Backannotation

.VHD / .VHO VHDL Source 

.EDF / .EDN EDIF Netzliste oder Backannotation

.XRF Cross – Referenz

.NET Sonstige Netzliste

Anmerkung

• Zur Weitergabe und externen Bearbeitung von Designs ist nur das Design-File *.dsn erforderlich, da 
alle Designdaten hier enthalten sind. 

• Das Projekt-File *.opj ist sinnvoll, aber nicht zwingend nötig. Es enthält gewisse Voreinstellungen zum 
Projekt, wie verwendete Libraries, Ausgabedateien, Ordnereinstellungen usw. 
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Please do not hesitate to contact us.

Für weitere Fragen und Informationen stehen wir gerne zur Verfügung.

FlowCAD Deutschland

Mozartstr. 2

85622 Feldkirchen bei München

T +49 89 45637-770

info@FlowCAD.de

FlowCAD Schweiz

Hintermättlistr. 1

5506 Mägenwil

T +41 56 485 91 91

info@FlowCAD.ch

FlowCAD Polska

ul. Sąsiedzka 2A

80-298 Gdańsk

T +48 58 727 90 90

info@FlowCAD.pl

Contact us / Kontakt zu FlowCAD 
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Follow Us

Don’t forget to subscribe, share and like! 

twitter.com/

FlowCAD

On FlowCAD’s 

Twitter we provide 

press releases, 

news articles, films 

and images as well 

as reports from 

events.

youtube.com/

FlowCAD

On our YouTube 

channel you can 

find 100+ tutorials 

to learn more about 

electronic circuits. 

Our playlists also 

offer product news 

and webinars.

facebook.com/

FlowCAD

Join our Facebook 

page. You will find 

selected news, 

events, success 

stories and 

insights.

FlowCAD.com/

newsletter

The FlowCAD 

newsletter for PCB 

designers appears 

about every two 

months. It is free 

of cost and will be 

sent by e-mail.

http://www.twitter.com/FlowCAD
http://www.youtube.com/FlowCAD
http://www.facebook.com/FlowCAD
https://news.flowcad.ch/?p=subscribe&id=3
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